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Dear customer,

Thank you for choosing Anycubic products.

Maybe you are familiar with 3D printing technology or have purchased
Anycubic printers before. However, we still highly recommend you read this
manual carefully, as the installation techniques and precautions can help you
avoid any unnecessary damage or frustration.

Please visit https://support.anycubic.com to contact us if you have any
questions. You can also learn more information from the website, such as

software, videos, models.

e

Anycubic support center

Copyrighted by “Shenzhen Anycubic Technology Co., Ltd ", all rights reserved.

Team Anycubic


https://support.anycubic.com/

Safety Instructions

Always follow the safety instructions during assembly and usage, to avoid

unnecessary damage to the 3D printer or individual injury.
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Please contact our Customer Service if you have any issues after
receving the products.

In case of emergency, please immediately cut off the power of the
3D printer and contact our technical support.

UV light is harmful to the eyes; please avoid direct contact. When
operating, wear protective equipment such as anti-UV goggles and
gloves.

Anycubic 3D printer includes components that can cause injury.

When the smart resin vat heats up for a long time, its surface
temperature becomes high. Avoid touching the resin vat without
protection after heating.

Be cautious when using the scraper, and make sure to orient the
sharp parts of machine and tool away from people.

Keep the Anycubic 3D printer and its accessories out of the reach of
children.

Vapors or fumes may be irritating at operating temperatures.
Always use the Anycubic 3D printer in an open and well ventilated
area.

Do not expose Anycubic 3D printer to any water or rain
environment.

Use Anycubic 3D printer in an environment with a temperature of
5°C-40°C and a humidity of 20%-80%. For optimal performance, do
not exceed this range. Also, avoid direct sunlight exposure.

Do not disassemble Anycubic 3D printer, please contact technical
support if you have any questions.




Contents

1. Product Overview

2. In the Box

3. Technical Specification

4. Recommended Print Parameters

5. Menu Directory

6. Preparations

7. File Upload

8. Print Test

9. Resin Exposure Range Finder

10. Machine Maintenance

11. FAQ

10

15

18

22

28

30

35



Product Overview
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Product Overview

Auto-fill Unit

Resin Pipe and Air Pipe
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Indicators*

Cap Part

Resin Input/ Output

Cap Part Wire

. *Indicators: Green light indicates the connection of the main module.
! Red light indicates that the resin in the bottle is insufficient.

Air Purifier

Top Cover

LED Indicator 0

Power Button
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Hex key set
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Screen protector kit

Auto-fill unit

Print platform * 1
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Protective equipment

Leveling Paper

Leveling paper
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Air purifier*1

Resin vat * 1 WiFi antenna
Funnel*5 Scraper * 2
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Manual * 1 USB drive * 1

Power cord



Technical Specification

Operating System

System Photon Mono M7 Pro
Touch Screen 5-inch Capacitive Screen
Software Anycubic Photon Workshop

(also compatible with other software)

Connectivity USB Drive, WIFI

Specifications

LCD screen 10.1 inch 14K
Light source COB light

XY Resolution 13312 %5120

Z axis Accuracy 0.01T mm
Suggested Layer Thickness 0.01 ~0.15 mm

Physical Dimensions

Dimension 310 mm(L) *315 mm(W) *520 mm(H)

Build volume 223.64 mm(L) *126.48 mm(W) *230 mm(H)
Weight 12.8 kg

WiFi

Frequency Range 2.4 G (2.400~2.4835 GHz)

Work Mode AP, STA, AP+STA mode



Recommended Print Parameters

@ Default @ Default ® High Speed
Parameters Group Resin_Normal Resin_Fast Resin
Layer Thickness 0.05 mm 0.1 mm 0.1 mm
Normal' Exposure 185 oy 145
Time
Off Time 0.5s
Bottom.Exposure 25 < 25 < 155
Time
Bottom Layers 5 3 3
Z Lift Distance 8 mm 4 mm 4 mm
Z Lift Speed 6 mm/s 15 mm/s 15 mm/s
Z Retract Speed 6 mm/s 15 mm/s 15 mm/s
Anti-alias 1
1.If the print object needs high accuracy, please use
group @ and modify the anti-alias level as 16 and the
image blur as 3.
2. The group @® apply to the model whose hollowed
thickness is no more than 2mm.
3. The group @® can significantly increase the print
Notice speed by cases test. To ensure the print success and print
speed, do not modify the parameters casually.
4. The group @® must work with the ACF release film
this printer provided to avoid print failure. The film can
be used to print 45000 layers.
5. The group ® only apply to Anycubic high speed resin.
6. Refer to 18-19 pages for the instructions of parameter
groups.

--The data above root in Anycubic lab, only for reference.



Menu Directory

Note: The current interface is for reference only. Please refer to the latest

firmware for accurate information.

Home menu

1.Smart resin vat connection
PR 2.Statistic of print layers
Photon Mono M7 Pro 3.Statistic of circulation time
ST 4.Resin bottle connection
- B o
Resin temperature
B2sc

Print

Print:

Switch to local/ USB
drive/cloud file list pwm

Click to enter into file details;
long press to edit the files.

File Details:

ormal
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Menu Directory

Tools

Move Z:

MoveZ  Exposure Cleaning Advanced ao-=

Anre
-@- - Tmm 10mm 50mm

Move the Z axis upwards

)

Z-axis Home

-~
-
~>

Check Leveling

Exposure:

- 20s 30s 40s 50s
Vat Cleaning:
Advanced:

osure  Cleaning Advanced |67

Smart resin vat

Load & Unload

Equipment self-test

11

Move Z by 0.1Tmm
/Tmm/10mm/50mm

Move to check the effect
of manual leveling
(see page 30-31)

Choose an image to expose

Set the exposure time

Smart resin vat



Menu Directory

Tools

Advanced-Smart resin vat:

Set heating temperature

Advanced-Load & Unload:

Advanced-Air Purifier:

connection first.

_____________________________________________________________________________________________

Check whether
WIFI module is on

Statistics of print layers

Exposure

Smart resin vat

Load &Unload

Air Purifier

Equipment self-test

Cleaning Advanced

> Auto Heating
Temperature

>

Circulation Cleaning
>

>

posure  Cleaning Advanced

Load & Unload

Air Purifier

Equipment self-test

MoveZ  Exposure

Smart resin vat

Load & Unload

Air Purifier

Equipment self-test

Exposure

Smart resin vat

Load & Unload

Air Purifier

Equipment self-test

> Feed

>

>

>

Cleaning Advanced

Air Purifier

When you enable "Air Purifier” , the connection of auto-fill unit will be disabled.
To use the auto-feeding and unloading functions, please turn off air purifier

Cleaning Advanced

Force Detection

WiFi Module

Print times

Print layers 10Q

Cycle time

12

100.00% ©

" Enable/disable the

connection of air purifier

_____________________________________________________________________________________________

Start force detection



Menu Directory

Information

Print logs:

Print history,
Long press to edit

Printlogs  Devi
TEST 1 2023/09/19.
TEST 2 2023/08/03
TEST3 2023/09/19

TEST 4 2023/09/19

Device:

Device name Anycubic Photon Mono M7 Pro M a c h i n e ty p e
Used space/total space g -1
o )
F a Cto ry re S Et Factory data reset >
Device ID JHON-4929-GYBG-2698 P ri nte r I D

Version:

Printlogs  Device Version

System version

System version

Application version

Application version

Local upgrade

OTA upgrade :

13



Menu Directory

Settings

Cloud: App connection
WIiFi connection status

Cloud Netwc uide B o T

WLAN Not connacted @ >

App connection IS

Anycubic App Not connected @ >

Printer’s hotspot (which
—— ° is hidden when the
. oo network is connected)

Network:

Cloud  Network Language

WIiFi connection

WLAN >

Set server

Server Location Global >

4E-74-Da-0C-D3-F1 >

10.2.32.104

Language:

Cloud rk  Language

English LD
Deutsch PycKuih s3bik
Espafiol Francals

Italiano BAE

Guide:

Cloud  Network  Language  Guide

@  install print platform

2)  Install resin vat

14



1. Unbox, and take out the machine and its accessories.

2. Install the screen protector.

@) | LS ap

Peel off the protective film Peel off the film ® Align the locating holes
Clean the LCD screen Squeeze out the air bubbles

Peel off the film @

3. Check the input mode of power voltage first. The one shown as “230" is
suitable for 200V-240V; and the other one shown as “115” is suitable for
100V-120V. Then, connect to the power adapter, flip the rocket switch to
ON position and hold down the start button for 2s.

the underside of printer

Y | [ |

PHOTON MONG

7

15



4. Set the system language and choose “Global” server. Then, complete

the on-screen setup steps.

Push the platform onto Tighten the knob
the platform carrier

6. Install the WiFi antenna.

Put resin vat with its feet Tighten the two knobs
stuck in locating holes

16



8. Install the auto-fill unit (optional).

l1kg

Use Anycubic 1kg
resin bottle

Attention:

1. Itis suggested to use the resin with a viscosity below 2000pcs, and place the
resin bottle behind or on the right side of the printer.

2. Never vigorously shake or turn over the resin bottle when the cap part s
installed. If the inside of the cap is stained by resin, please immediately clean it
to avoid malfunction or damage to auto-fill unit.

3. The operating temperature for auto-fill unit is 10-40°C and the humidity range
is 20-80%. For optimal performance, do not exceed these limits. If using
Anycubic Bio Resin or Anycubic Rigid 100 Resin, the recommended ambient
temperature is over 25°C. Otherwise, the functions of auto-fill unit may fail.

S e == P

9. Prepare the air purifier (optional). Due to sharing a single interface, the
air purifier and the auto-fill unit cannot be used simultaneously. You can

choose one device to use according to the personal requirement.
Remove the package
of carbon

17



File Upload

USB

1. Use Anycubic Photon Workshop software to process the 3D model file.

The installer and instructions is saved in the USB drive.

2. When you set the parameters in Anycubic Photon Workshop, there are

three groups of parameter which can be apply to the print with different

needs.

Preset Printers Machine Resin

Anycubic Photon Mono M7 Pro

n | ‘ Edit Resin | [T B R | B |
Name Resolution Exposure Lift Bottam
DefaultResin_Normal  ([(XEme) ::m:h
Default Resin_Fast [ 0:100mm | [ 2.200]
High Speed Resin [ 0:100mm | [ 1.4005 |

Choose the parameter group according to the personal requirement

@ Default Resin_Normal

Apply to the Anycubic resin with normal printing speed. If the print object
needs high accuracy, please modify the anti-alias level as 16 and the
image blur as 3.

@ Default Resin_Fast

Apply to the Anycubic resin with fast printing speed. The layer thickness is

0.1Tmm. Optimizing the Z-axis motion control increases the print speed.

18



File Upload

® High Speed Resin
Only apply to the Anycubic high speed resin with the fastest printing speed.
The layer thickness is 0.1mm. Optimizing the Z-axis motion control

increases the print speed.
Notice for parameter group@0®:
1. The parameters apply to the model whose hollowed thickness is no more than
- 2mm.
2. The parameters must work with the ACF release film this printer provided to

avoid print failure. The film can be used to print 45000 layers.

3. Save the sliced file to USB drive.

4. Then, insert the USB drive to the printer.

USB drive:

1. Itis recommended that use the USB drive we provide. If you are using your
own USB drive, please ensure that it is formatted to FAT/FAT 32 and has a

. memory size of less than 64G.

2. To ensure proper file reading, please put print files in the root directory of USB
. drive.

/
I
'

19



File Upload

Cloud

Please connect the printer to Anycubic App first for remote uploading and monitoring.

1. Connect to the network.

in App Store or Goolge Play, or scan the QR
code on the printer, to download Anycubic App. Then, sign up and sign in.

2. Please search “Anycubic”

3. Add a printer in Anycubic App.

Workbench < Add printer

B File > O Task >

—_— Please follow these steps to complete adding the printer
FI 1. Complete the assembly of the printer
2. Turn on the printer switch and complete the

networking operation

3. Scan the QR code of the device CN

Scan the QR code to
add printer

Help

Photon M3 Max FHAR1EHI3 “
)
Workbench

20



File Upload

4. Search model or upload the model files.

e Search model

Workbench Search model

More than 1 million printable 3D N

B Fie > O Task >
& Popular searches:  alien  flexi  harry potter

5 deadoralive  onimask terminator v
Printer

Recommend Sliced Newbie zone

Anycubic Photon Mono M7 Pro

Total printing time: 0 hour 0 min
Total consumption Resin: Oml
Printer type: Anycubic Photon Mono M7 Pro

.
N tortoise Free 3D print Gridfinity Pick + Tweezer
model recommendation CChange model
Cgtrader Thangs
. n nm
Batman on a roof CATBUS(MY NEI..  Cobb Vanth
Early summer Early summer Early sum)
Help More > Ironman helmet with Succubus
e Ping opening mechanism -
angs
. 5 c
© <) @ (o] )

Search model

Workbench

* Upload the modelfiles

Workbench < File Space use0.008/2.00G8

B Fi > O Task >

Printer

There are currently no printable files, Please upload model or
slice files

Anycubic Photon Mono M7 Pro

Total printing time: 0 hour O min

Total consumption Resin: Om! printer model recommendation C Change
Printer type: Anycubic Photon Mono M7 Pro
B Batman on a roof
.
model recommendation CChange ® «ie white

CATBUS(MY NEIGHBOR TOTORO)

/8 Daniel Toledo

’_m Cobb Vanth from Star Wars the

1 Mandalorian
Cobb Vanth *%ﬁ
&

Batman on a roof CATBUS(MY NE|

@ Harry Olvera

Early summer Early summer Early sum
5 Chained One
Help More >
. p - @ Harry Olvera
© ® Q
Workoench

21



Print Test

Resin Preparations

*The release film on the resin vat is consumable. Please pay attention to the
status of release film on the touch screen and replace the film timely.

Please check the release film carefully before and after every printing. If the film
is broken, replace it immediately to avoid further damage to the machine.

1. Make sure to wear a mask and gloves (to avoid direct skin contact with
the resin), slowly pour resin into the vat, and make sure it is within the vat’s
maximum scale.

2. Enable the automatic feeding (optional). Please install the auto-fill unit

before using.

. TIPS: When using resin with a viscosity over 500cps at room temperature (25°C),
the resin bottle may experience slight deflation or inflation due to pressure ‘
changes. This is normal and does not affect loading and unloading.

22



Print Test

3. Insert the air purifier (optional). There are two methods to turn off the
purifier: (1)Enable the connection of air purifier on the touch screen and

then press the power button of purifier; (2)Unplug the air purifier.

Insert the purifier Enable the connection Press its power button
and it will start of air purifier

4. When the ambient temperature is below 20 °C, it may cause the
detachment of printed bottom or partial loss of printed objects. You can

enhance the printing effect by enabling preprint heating.

Enable preprint heating. The printing starts when the resin temperature
reaches 25 °C.

Attention:

: 1. Material circulation is enabled by default during heating process.

2. When the resin vat heats up for a long time, its surface temperature becomes
high. Avoid touching the resin vat without protection after heating.

5. Put on the cover.

23



Print Test

Print File

Print USB drive file

ANveuBic:

Layer Thickness
© Resin

© Time

B Speed Mode

§

© 2005 © 2nismin © 1ihimin ©1200 @ 10n12min

TEST4

[

Remote print

Workbench < Print Online slicing

Cloud Local
B File > O Task >
Printer: Anycubic Photon Mono M7 Pro

Printer More > TEST st

Type: model file
.g Size: 54.35MB
Anycubic Photon Mono M7 Pro 2022-03-25 10:00:00
. e

Total printing time: 0 hour O min & Prig
Total consumption Resin: Oml
Printer type: Anycubic Photon Mono M7 Pro
TEST.stl
< . Type: model file
model recommendation CChange "% Size: 54.35MB
& 2022-03-25 10:00:00
B -
h <& Print
& ‘ & 11.11%22.2243 3mm

Batman on a roof CATBUS(MY NEL... Cobb Vanth @ Anycubic Photon Mono

Early summer Early summer Early sum
Slicing template
Help More > High speed
© Q
Workbeneh

24



Print Test

Before printing

1. Before printing, the printer checks the hardware condition, resin volume
and residue before each print job. When there is an error, the printer will

pop up the error QR code. Please scan the code and follow the guide.

a6z

Platform Detection

Before printing, check whether the print platform is installed.

Residue Detection

Before printing, check if there are the solid residues® in the resin vat. If residues
are detected, please clean the vat and check again.

*solid residue: height=3mm, cross section=9mm?

Resin Detection

Before printing, check whether the resin in the vat is sufficient to finish the print
job. Usually, the required volume is a little more than the volume estimated by
the slice software.

If the auto-feeding is enabled, the equipment will automatically replenish the

resin when it detects the resin insufficiency.

2. If the in the bottle is insufficient, the printer will pop up warning. Please

refill or replace the resin bottle timely.

1kg

3. The feeding before printing can be skipped. If skipped at this time, it will

not occur during printing.

4. You can choose to skip heating if necessary. Please be cautious, as low

ambient temperature and insufficient heating time may lead to print failure.

25



Print Test

In Printing

Failure detection: During printing, the printer automatically monitors the
conditions which may cause print failure to avoid wasting resin or
damaging to the printer. When the printer detects an abnormal condition, it
will pause the print job automatically and pop up the error report. Please
check the sliced file and the model according to the report. The failure

detection is enabled by default.

Bottom non-stick detection

It checks whether the model sticks to the print platform.

When the printer detects that the model does not stick the platform, please
check the bottom exposure time of the sliced file.

Off compensation: When the exposure area is large during printing, due to
the surface tension and the resin characteristic, there may be problems
such as delay of Z-axis or delay of resin reflowing, resulting print failure.

The function is enabled by default.

Intelligent release: The function can improve the printing success rate by
optimizing algorithm. Enabling intelligent release while printing with the
default resin_normal parameter group can also increase printing speed.

The function is disabled by default.

Before printing, the functions can be enabled/disabled in the print function

interface.

26



Print Test

After Printing

1. After printing, remove the platform when resin stop dropping from the
platform. Remove the model by metal scraper and then wash it with 95%
alcohol or other detergent. After cleaning and drying, proceed with post-

curing and any other necessary post processing of the model.

2. After printing, click “Unload” to recycle the resin. Use a plastic scraper
to guide resin to the output of the auto-fill unit, facilitating the unloading
process. However, if the printing fails, do not enable the unloading
function to prevent the auto-fill unit from blocking or being damaged.

3. When the printing fails, resin may be cured partially in the vat. Please set
to Cleaning and remove the residue. Otherwise, it may cause damage to
the release film or LCD screen.

e a plastic spatula to lft the residue from the vat

Remove resin sheet
by plastic scraper

4. Please pour out the remaining resin through a front spout of the vat, and
filter it by a funnel. Do not pour out the resin through the back side of the

vat to avoid the damage to the resin vat.

Vat spout -----; .=



Resin Exposure Range Finder

“R_E_R_F" is an abbreviation for “Resin Exposure Range Finder” . This function

is used to find out the optimal exposure parameters for different resins.

1. Import the R_E R F file which is saved on USB drive into the slicing
software. There are eight models in the file. The exposure time for model 1
is equal to "normal exposure time (s)" of the file, and the exposure time for
other models will be increased by an increment of 0.25 s.

For example:

WACNBIC

=2
A5,
o ©o
=

The numbers on the models indicate the order

2. According to the personal requirement, adjust the exposure time of the
models by modifying "normal exposure time (s)“ of the file. When
exposure time for Model No. 1 is changed, the exposure time for other

models will be increased by an increment of 0.25 s.

For example, when normal exposure time is set to 1.5 s, the exposure time
for Model No.1-8is:1.5/1.75/2/2.25/2.5/2.75/ 3/ 3.25 s.

3. After printing, remove and clean the models. Compare the print effect of
models and choose the model’s exposure time that meets your needs as

the print parameter. Take a comparison of model A&B as an example.

28



Resin Exposure Range Finder

e oy More cylinder

« Model A has more holes and fewer cylinder. If you print by the parameter
of model A, more details of model can be printed with high risk of failure.
« Model B has fewer holes and more cylinder. If you print by the parameter

of model B, model may be printed successfully yet with some details lost.

In addition, you can compare the bridges, needles or other parts to choose
a proper model and find the parameter. If none of them can be chose,

adjusting the "normal exposure time (s) " is suggested.
Notice: DO NOT change the file name of “R_E_R_F”, because Anycubic 3D printer

can only recognize THIS file name to run this function. Also, do not name other
fileas "R_E R F".

29



Maintenance

Leveling

The printer has been designed requiring no
leveling for the first use. However, please re-
level the printer in the following scenarios:

* The print platform has been fallen to the

ground.
Scan the QR code for

* Changing new print platform or LCD screen. . .
the leveling tutorial

» The printed object sticks to the resin vat

instead of the print platform.

Please follow the steps below to install and re-level.

1. Install the print platform.

vV /
Loosen the four Push the platform onto Tighten the knob
leveling screws the platform carrier

2. Leveling.

ERR R T
Leveling Paper

(o

=
m

Place the leveling Click “Z-axis Home" Lower Z axis by Tmm
paper (included)
on the LCD screen

30



Maintenance

I
| ity

-

If the print platform Lower until there is resistance

shakes with light press, when pulling out the leveling
lower Z axis by paper, hold the platform and
0.1mm each time tighten the four screws

3. Check whether the leveling is successful. If it does not match the result
shown below, please loosen the four leveling screws and follow the step2

to re-level .

10mm 50mm

Click “Check Leveling” When you pull the
leveling paper, there is a
significant resistance or

it cannot be pulled out

31



Maintenance

Resin Vat Maintenance

* Remove the cured resin from release film: Set Cleaning and then

remove the cured resin sheet to protect the film. Do not use sharp objects
to scrape off the residues from the film.

Use a plastic spatula to ift the residue from the vat

Remove resin sheet
by plastic scraper

Remove the liquid resin from resin vat: If there is only liquid resin in the

vat, pour out the resin and then follow the steps of circulation cleaning to
clean the vat.

Release film replacement: The statistics of print layers are shown in

Home menu. Please check them and replace release film timely to avoid
print failure or even the damage to printer.

aox a6z a6z
Photon Mono M7 Pro Photon Mono M7 Pro Photon Mono M7 Pro
‘Component status Component status
e/ Installed

@ 45000 s

‘e Installed

@ o

) 0.00%

E]' Installed

Need to replace Click reset button

) 0.00%

EL Installed

release film after replacement

» If you do not use the resin for over 48H, store it in an airtight container
away from light.

 If resin is stained on the resin vat, wipe it off timely. Never immerse the

smart resin vat in water, alcohol or other cleaning solvent to avoid the
damage.

 Itis suggested to use non-flexible resin with a viscosity below 1000 cps.

32



Maintenance

Replace Peristaltic Pump Pipe
Please replace the peristaltic pump pipe when the circulation time reaches
100%, as shown on the Home menu.

1. Put on gloves.

2. Remove the used peristaltic pump pipe.

Remove the pump pipe

3. Install a new peristaltic pump pipe.

| “ ‘-! S
Insert a new pump pipe Secure the bottom of Grease the pipe and shaft
pipe with 2 zip ties

3 100.00%

E], Installed

Put on the front cover Tighten 2 screws on the back Reset the circulation time

i Please fully insert the new pump pipe to the bottom to ensure proper installation.

33



Maintenance

Firmware Upgrade

« USB upgrade: Visit the official website to download the firmware and
save it onto a USB drive that doesn’t have any other version of firmware.
Then, insert the USB drive to printer to upgrade.

* OTA upgrade: If the network is connected, directly upgrade by OTA.

Z-axis Maintenance

If Z axis makes a noisy sound, please apply lubricant to Z lead screw.

Cleaning

* Clean the print platform: Clean platform with alcohol and paper towel.
« Protect LCD screen: If there is resin being cured on the screen protector,
please replace the protector immediately.

* Clean the body of printer: Clean the body of the printer with alcohol.

34



Complete the initial trouble shooting steps by referring to the following proposed

solutions, or contact our technical support for additional assistance.

Print

1. Model do not stick to platform
+ Bottom exposure time is insufficient. Please increase the exposure time.

» Contact area between the model and platform is small. Please add a raft.

2. Layer separation or splitting

* The machine is not stable during printing.

* The release film is not tight enough or needs a replacement.
» The printing platform or resin vat is not tightened.

» The lift speed is too fast.

» The model is hollowed without punching.

3. Layer shift
» Add supports.
* Reduce the lift speed.

4. Floccules left in resin vat or attached to models
* The exposure time is too long. Reduce the normal exposure time and

bottom exposure time.

Cloud connection

1. WIFI connection is failed

» WiFi name or password is wrong. Please reset the network and reconnect.

* The WiFi network is unavailable. Join an available network. Then, reset

the network and reconnect.
2. Fail to add printer in App

* Check "Server Location” . Users in mainland Chinese please select

"China", users in other countries and regions please select "Global".

35



Complete the initial trouble shooting steps by referring to the following proposed

solutions, or contact our technical support for additional assistance.

Auto feeding & Unloading

1. The printer prompts that resin in the vat is not enough before printing.

» The auto-fill unit has a poor connection to the printer. Please reinstall the
auto-fill unit and then click “OK" .

» The auto-fill unit has been malfunctioned because resin entered in the
air pipe.

2. The resin in the bottle is sufficient, but the printer prompts no resin in

the bottle.

* The cap part has a poor connection to the printer. Please reinsert the cap

part wire.

3. The resin liquid level reaches the needles of the auto-fill unit. However,
when you click “unload”, the printer immediately prompts that
unloading completes.

+ The thumb screws securing the resin vat are not tightened. Please stop

unloading and tighten the thumb screws.

4. The green light of auto-fill unit is off and load, unload as well as auto-
feed option is invalid.
» Check whether the air purifier connection is enabled. Enter into “Tools” -

“Advanced” - "Air Purifier” , and disable “connect to air purifier” .

Thank you for purchasing Anycubic products! Under normal usage and
service, the products have a warranty period of up to one year. Please visit
Anycubic support center(support.anycubic.com/en) to report any issues
with Anycubic products. Our professional after-sale service team would
respond within 24 hours and solve the issues.
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